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IntroductionAlarmPoint Mobile Gateway for BMC Remedy Service Desk
1. Introduction
This document defines software requirements, installation, configuration, and integration demonstrations for using the BMC 
Remedy Service Desk with the AlarmPoint Mobile Gateway. These integration notes are intended for administrators and 
other technical readers. 

1.1 Summary
AlarmPoint is an interactive alerting application, designed to capture and enrich important events, to route those events to 
the right person on any communication device, and to give that person the ability to solve, escalate, or enlist others to resolve 
the events remotely.

AlarmPoint allows you to take critical business information and contact the right people via voice phone, SMS, two-way 
pagers, instant message, and email.

Through integration modules, the AlarmPoint System can become the voice and interface of an automation engine or 
intelligent application (the Management System, such as BMC Remedy Change Management). When Remedy detects a 
change request that requires attention, AlarmPoint places phone calls, sends pages, messages, or emails to the appropriate 
personnel, vendors or customers. 

The AlarmPoint System is also persistent, escalating through multiple devices and personnel until someone accepts 
responsibility or resolves the request. Once contacted, the AlarmPoint System gives the notified person instant two-way 
communication with BMC Remedy. Responses are executed immediately on BMC Remedy, enabling remote resolution of 
the incident.

This integration supports creating, viewing, and updating BMC Remedy Service Desk incidents through the use of the 
AlarmPoint Mobile Gateway, AlarmPoint Integration Agent, and Web Service Calls. 

You will need to modify this configuration to suit your particular business requirements and adjust it to suit your expected 
loads. The default integration features loading list values directly from Service Desk; in a high-volume production system, 
this can significantly affect performance. Consider your expected volume of requests to the Mobile Gateway, and your server 
capacity when designing your own integration. 

1.1.1 Benefits 
With the AlarmPoint Mobile Gateway, the appropriate technician can create, view, and update Service Desk incidents 
directly via a mobile device web browser. Information about Service Desk incidents can be displayed on the mobile device 
and updated in real-time. 

The benefit is that this process is immediate and may be done remotely – providing users with an efficient method of 
handling Service Desk issues from any mobile device. In addition, the Service Desk Integration can be updated to notify 
AlarmPoint Users on their mobile device with a link to the mobile view of the incident, allowing the user to update the 
Incident remotely.
Summary   |  1
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1.1.2 Architecture
This section provides a high-level overview of the major components for this integration.

The following steps occur for each action initiated by a mobile user:

1. A user sends a request from a mobile device to the AlarmPoint Mobile Gateway.

2. The Mobile Gateway processes the request and relays instructions to the AlarmPoint Integration Agent.

3. The Integration Agent communicates with BMC Remedy Service Desk via Web Services.

4. The response is sent via Web Services to the Integration Agent.

5. The Integration Agent processes and wraps the response and sends it back back to the Mobile Gateway.

6. Rendered results are sent back to the mobile device.

1.2 System Requirements
This integration requires the following products and components:

• AlarmPoint 4.0 (patch 004 or later) with AlarmPoint Integration Agent 4.0
OR
AlarmPoint 3.2.1 (patch 012 or later) with AlarmPoint Integration Agent 3.2.1

• BMC Remedy Action Request System 7.5 patch 002

• BMC Remedy Mid Tier 7.5 patch 002

• BMC Remedy Service Desk 7.5.01

Consult the respective user manuals for a detailed list of hardware and supporting software requirements.

Note: All AlarmPoint browser pages have been designed to work with BlackBerry Handheld Software v4.2.x. The 
browser-accessible pages may not display properly on mobile devices with other software versions.
System Requirements   |  2
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1.2.1 Supported Operating Systems
The following operating systems are supported by this integration:

• Microsoft Windows 2003 (validated)

• Sun Solaris 9, 10

• HP-UX PA-RISC B.11.23

• AIX 5.3

• Linux RedHat AS/ES 4, 5

1.3 Conventions & Terminology
This section describes how styles are used in the document, and provides a list of definitions.

1.3.1 Conventions
Some instructions appear in the following format: MENU > OPTION; for example, File > Open means click the File menu, 
and then click the Open menu option.

Words in bold typically reference text that appears on the screen.

Words in monospace font represent the following:

• text that must be typed into the computer.

• directory and file names.

Directory placeholders

The location to which you install AlarmPoint is referred to throughout this document as <APHOME>. 

• For example, the C:\Program Files\AlarmPointSystems\AlarmPoint\webserver\webapps\cocoon\jsp 
folder in a default AlarmPoint Windows installation would be referred to within this document as 
<APHOME>\webserver\webapps\cocoon\jsp.

The location to which you install the AlarmPoint Integration Agent is referred to throughout this document as <IAHOME>.

On Unix systems, the AlarmPoint Integration Agent is typically installed in /opt/alarmpointsystems/
integrationagent. On Windows systems, it is installed in the default directory C:\Program Files\ 
AlarmPointSystems\IntegrationAgent.

Note: Except where explicitly stated, the directory paths in this document are listed in Windows format. Unix users must 
substitute the given paths with the Unix equivalents. 

1.3.2 Terminology
With respect to BMC Remedy Service Desk, the following definitions apply:

Term Meaning

Incident Item of interest detected by Service Desk.

Work Info Refers to an item in the Work Info History.
Conventions & Terminology   |  3



IntroductionAlarmPoint Mobile Gateway for BMC Remedy Service Desk
With respect to the AlarmPoint System, the following definitions apply:

Term Meaning

AlarmPoint Integration 
Agent

A flexible JavaScript processing engine that allows third-party management systems to 
expose their functionality to mobile and web-based users, while leveraging the 
AlarmPoint infrastructure to provide high security and fault tolerance   

AlarmPoint Application 
Server Node

The core AlarmPoint application, consisting of various components that process events 
and perform notifications.

AlarmPoint Web User 
Interface

Browser-accessible interface for controlling AlarmPoint components and information.

AlarmPoint Notification 
Server Node

Delivers notifications to a person in a variety of ways (pager, phone, email, etc.)

AlarmPoint System Umbrella term for all AlarmPoint software components

Management System A generic term for BMC Remedy Service Desk

User Guides The AlarmPoint documentation suite, which includes the AlarmPoint Installation and 
Administration Guide, the AlarmPoint Developer’s Guide & Scripting Reference, the 
AlarmPoint User Guide, and the AlarmPoint Integration Agent Guide.
Conventions & Terminology   |  4



InstallationAlarmPoint Mobile Gateway for BMC Remedy Service Desk
2. Installation
The integration assumes the following: 

• BMC Remedy Service Desk is installed and operational

• the ARS User Application is installed

• the ARS Administrator Application is installed

• BMC Remedy Mid-Tier is installed and operational (for Web Services)

• AlarmPoint is installed and operational 

• the required users and groups are configured

2.1 AlarmPoint System
This integration requires the following AlarmPoint applications to be installed:

• AlarmPoint

• AlarmPoint Integration Agent

2.1.1 AlarmPoint
For installation instructions, refer to the AlarmPoint Installation and Administration Guide.

Note: When installing AlarmPoint, you must select the option to install the AlarmPoint Webserver.

2.1.2 AlarmPoint Integration Agent
The AlarmPoint Integration Agent must be installed on the same computer as BMC Remedy Service Desk. For instructions 
on installing the Integration Agent, refer to the AlarmPoint Integration Agent Guide.

2.2 Installing BMC Remedy Service Desk
Consult the Service Desk documentation for instructions on how to install and configure BMC Remedy Service Desk and 
BMC Remedy Action Request System.

2.3 Installing the Integration
After the BMC Remedy Service Desk and AlarmPoint systems have been installed, integration components must be placed 
on each system. The integration archive contains updates for AlarmPoint and the AlarmPoint Integration Agent, and files for 
the BMC BMC Remedy Service Desk Server. 

Note: Before installing the integration, shut down or stop all AlarmPoint processes.

Extract the AP-MG-BMC-Remedy-SD archive file.

The significant files and directories (in bold) of the archive are as follows:

|-- components
| |-- alarmpoint
AlarmPoint System   |  5
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| | ‘-- mobilegateway
| |   |-- bmcremedysd
| |   ‘-- libs
| |     ‘-- apbridge.jar
| |-- alarmpoint-integration-agent
| | ‘-- bmcremedysd
| |   |-- lib
| |   |-- bmcremedysd.js
| |   ‘-- bmcremedysd.xml
| ‘-- bmcremedysd
|   ‘-- APServiceDeskMG.def
‘-- documentation
  |-- AP40-MG-BMC-Remedy-SDv70.pdf
  ‘-- AP40-MG-BMC-Remedy-SDv75.pdf

2.3.1 Installing the Web Services Library
To enable Web Service calls between AlarmPoint and the Service Desk server, you must copy the JAR file into the 
AlarmPoint Webserver library folders. 

Source File: 

AP-MG-BMC-Remedy-SD\components\alarmpoint\mobilegateway\libs\apbridge.jar

Web Server Destination Directory: 

<APHOME>\webserver\webapps\mobilegateway\WEB-INF\lib

Note: If you have installed more than one web server; install the JAR file into the library folder for each one. 

2.3.2 Installing the Mobile Gateway Integration files
To install the Mobile Gateway, you must copy the JSP files to the AlarmPoint installation folder.  If you have more than one 
web server; repeat the following step for each one: 

Copy the bmcremedysd directory from components\alarmpoint\mobilegateway\ in the extracted archive into 
the <APHOME>\webserver\webapps\mobilegateway\jsp directory of the AlarmPoint installation. 

2.3.3 Installing the Integration Service 
To install the Service Desk integration service, you must copy the bmcremedysd.js and bmcremedysd.xml Integration 
Agent files into the integrationservices directory, and then modify the Integration Agent’s IAConfig.xml file to 
include them. Repeat the following steps for each Integration Agent providing the bmcremedysd service: 

1. Copy the bmcremedysd directory from components\alarmpoint-integration-agent\ in the extracted archive 
into the <IAHOME>\integrationservices directory of the AlarmPoint Integration Agent installation 

2. Open the <IAHOME>\conf\IAConfig.xml file and add the following line to the service-configs section: 

<path>bmcremedysd/bmcremedysd.xml</path> 

3. Open the bmcremedysd.js file (now located in <IAHOME>\integrationservices\bmcremedysd\) and modify 
the following parameters:

• RemedyURL: replace “localhost” with your Remedy server’s IP address.

• RemedyServerName: replace “REMEDYCM” with the name of the server hosting Remedy webservices.
Installing the Integration   |  6
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4. Save and close the bmcremedysd.js file, and then restart the Integration Agent.
Installing the Integration   |  7
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3. Configuration
Before you can begin using the integration, you must configure BMC Remedy Service Desk and AlarmPoint. This chapter 
explains the configuration processes required for each product.

3.1 Configuring BMC Remedy Service Desk
Configuring Service Desk for the integration requires the following steps: 

• Import the workflow definition file

• Add the AlarmPoint entry for Work Log information

• Configure Product Categorization and Operational Categorization Lists

3.1.1  Importing the Workflow Definition File 
The workflow described in this document is provided in a definition file that must be imported into BMC Remedy Service 
Desk. 

To import the workflow definition file:

1. Login to the BMC Remedy Developer Studio, and then select File > Import.

2. Select BMC Remedy Developer Studio > Object Definitions, and then click Next.

3. Select the AR System server into which you want to upload the integration objects, and then click Next.

4. Do one of the following:

• Type in the location of the APServiceDeskMG.def file.

• Click the Browse button to the right of the text field and navigate to the location of the APServiceDeskMG.def 
file. Select the file, and then click Open.

5. Click Next.

• If you have already imported a workflow definition file, ensure that you select the Replace Objects on the 
Destination Server check box, but note that any changes you have made to those objects will be lost. If you are 
sure the changes you made are necessary for your installation, ensure that the existing objects will work with the 
objects being imported, and do not select the Replace Objects on Destination Server check box.

6. Click Finish.

3.1.2 Adding the AlarmPoint entry for Work Log Information
To enable annotations, add the AlarmPoint category to the HPD:WorkLog form.

To add the AlarmPoint category to the WorkLog Menu:

1. Login to the BMC Remedy Developer Studio tool, and expand the server tree where the integration objects are 
installed.

2. In the server tree, expand All Objects, and then double-click Forms.

3. In the Forms dialog box, locate and double-click HPD:WorkLog.

4. Double-click the Work Info Type field.

5. In the Properties view, expand the property Attributes, and then select the sub-property Selections.
Configuring BMC Remedy Service Desk   |  8
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6. Click the Browse button to the right of the Value column.

7. In the Selections dialog box, click Add.

• A default value should be added to the bottom of the list.

8. In the Selection Values and Alias fields, specify AlarmPoint.

9. If the default ID provided is not acceptable, change it to a unique number.

10. Click OK, and then click File > Save.

3.1.3 Configuring Product Categorization and Operational Categorization Lists
The configuration.jsp file specifies the lists used by the AlarmPoint Mobile Gateway when searching for Product 
Categorizations and Operational Categorizations. These lists must be customized for your deployment.

To configure the Categorization lists:

1. Open the <APHOME>\webserver\webapps\mobilegateway\jsp\bmcremedysd\configuration.jsp file.

2. To specify the Product Categorization Tier 1 lists, locate the following section, and replace the values within quotes 
with the Product Categories Tier 1 values (this is also used when searching for Product Categorization Tier 2 and Tier 
3 values from the Mobile Gateway):

List<String> productCategorizationTier1 = new ArrayList<String>();
productCategorizationTier1.add("Hardware");
productCategorizationTier1.add("Miscellaneous");
productCategorizationTier1.add("Network");
productCategorizationTier1.add("Service");
productCategorizationTier1.add("Software"); 

3. To specify the Operational Categorization lists, locate the following section, and replace the values within quotes with 
the Operational Categories Tier 1 values  (this is also used when searching for Operational Categorization Tier 2 and 
Tier 3 values from the Mobile Gateway):

List<String> productOperationalTier1 = new ArrayList<String>();
productOperationalTier1.add("Request");
productOperationalTier1.add("Faliure");

4. Save and close the configuration.jsp file.

3.2 Configuring AlarmPoint
Configuring AlarmPoint requires the following steps

• Define an Event Domain.

• Define an Integration Service.

• Define Custom Fields

• Add an AlarmPoint Mobile Gateway User.

3.2.1 Defining an Event Domain
The AlarmPoint webserver must be running to perform this portion of the integration. 
Configuring AlarmPoint   |  9
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Note: If the “bmcremedysd” Event Domain is already configured in AlarmPoint (for use with the AlarmPoint for BMC 
Remedy Service Desk Advanced integration), you can skip this section.

To define an Event Domain:

1. Log in to AlarmPoint as a Company Administrator, and click the Developer tab.

2. On the Event Domains page, click Add New.

3. Enter the following information into the form:

• Name: bmcremedysd

• Description: BMC Remedy Service Desk Integration

• Script Package: BMC Remedy Service Desk

Note: If the BMC Remedy Service Desk script package option does not exist, leave the Script Package field blank.

4. Click Save.

3.2.2 Define an Integration Service
This integration uses a default integration service of “bmcremedysd”; it is strongly recommended that you use this default 
integration service. For the installation to be successful, the integration service name must match the service specified in the 
bmcremedysd.xml file installed on the Integration Agent.

To define an Integration Service:

1. In AlarmPoint, on the Event Domains page, click the bmcremedysd Event Domain.

2. On the Event Domain Details page, click Add New in the Integration Services area.

3. Enter the following information into the form:

• Name: bmcremedysd

• Description: BMC Remedy Service Desk Integration Service

• Path: bmcremedysd/menu.jsp

4. Click Save.

3.2.3 Define Custom Fields
The Mobile Gateway uses custom fields defined in AlarmPoint to hold the login information for Service Desk.  By default, 
the custom fields are “Service Desk User” and “Service Desk Password”; it is strongly recommended that you use these 
default field names.

Note: These custom fields are optional and do not need to be defined for the Mobile Gateway to function.

To define the custom fields:

1. In AlarmPoint, click the Admin tab.

2. In the Administration menu on the left side of the screen, click Custom Fields.

3. Click Add New.
Configuring AlarmPoint   |  10
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4. Enter the following Information info the form:

• Field Name: Service Desk User

• Type: Text

5. Click Save.

6. Click Add New.

7. Enter the following Information into the form:

• Field Name: Service Desk Password

• Type: Password

8. Click Save.

Note: For more information about custom fields see the AlarmPoint Installation and Administration Guide.

3.2.4 Creating a Mobile Gateway User
The “Has Mobile Access” check box on the User Details page determines whether a User can log into the Mobile Gateway. 
You can grant access to an existing User by selecting the Has Mobile Access check box, or create a new User and select the 
check box while adding them.

To allow the default User to access the Mobile Gateway:

1. In AlarmPoint, click the Users tab.

2. On the Find Users page, click S. 

3. In the list of returned Users, click Smith, Bob.

4. On the Details for Bob Smith page, select the Has Mobile Access check box.

• If you defined the custom fields, enter the Service Desk User and Service Desk Password information into the 
custom fields.

5. Click Save.

Note: For more information about Mobile Gateway Users see the AlarmPoint Mobile Gateway Guide.
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4. Software Component Integration
It is recommended that the applications be run in the following order: 

• BMC Remedy Service Desk 

• AlarmPoint Integration Agent

• AlarmPoint Application and Notification Server Nodes

Consult the respective user manuals for details on starting these applications. 

4.1 Query for an Incident
The following validates that the Mobile Gateway, Integration Agent, and BMC Remedy Service Desk are properly 
configured. 

To query for a incident:

1. Log in to the Mobile Gateway as bsmith:

• If more than one Integration Service is available, select the bmcremedysd service:
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2. If prompted, enter the Service Desk login credentials specified in the custom fields:

3. Click the Query Incidents menu item:
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4. Enter the search terms using the fields and drop-down lists:

5. Click Submit Query.

• The Mobile Gateway should display a list of all Service Desk incidents matching the search criteria:

6. Click the IN# (Incident Number) for an incident to view its details:
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7. To resolve the issue, select Resolve Incident from the drop-down list at the top of the screen, and then click Go:

8. Type a summary in the Resolution field, and then click the Browse button beside the Reason field to select a 
resolution code. Click Resolve to apply the resolution and return to the Incident Details screen:
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The following screens illustrate some of the other navigational tools and options available through the AlarmPoint Mobile 
Gateway for BMC Remedy Service Desk:

Resolution Options and Work Info:
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5. Optimizing and Extending the Integration
This section describes some of the available methods you can use to optimize or extend AlarmPoint Mobile Gateway for 
BMC Remedy Service Desk.

5.1 Exposing a New Field 
In order for a new field that has been exposed in the Service Desk APSDI_HPD_HelpDesk_WS.HelpDesk_Detail_Query 
form to be displayed on the Mobile Gateway, you must modify the JSP files.

To add a field to display:

1. Open the <APHOME>\webserver\webapps\mobilegateway\jsp\bmcremedysd\includes 
\updateFields.jsp file in an editor.

2. Add an entry to the fields and fieldTypes variables; for example:

fields.put("Field Name", "Field Label");
fieldTypes.put("Field Name", "Field Type");

• If the field is required, add a variable to requiredFields; for example:

requiredFields.add("Field Name"); 

• The fieldNames variables use ::: to represent parent to child relationships. For example, 
Classification:::Operational_Categorization:::Tier_1 represents Tier_1 in the following XML 
sample:

<Classification>
  ...
  <Operational_Categorization>
    <Tier_1>Hardware</Tier_1>
    ...
  </Operational_Categorization>
  ...
</Classification>

Note: To escape a colon, use \:.

3. Save and close the JSP file.

Table 5-1. Possible Field Types

Field Type Description

Notice Renders the Field Label as an italicized message string.

Text Displays the value of this field in an editable text input.

TextArea Displays the value of this field in an editable text input for multiple lines.

Disabled Displays an input box containing the value, but does not allow input.

List If a list is defined, a drop-down list will be displayed for this field. See “Defining static lists”, 
below.
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Once you have added the field details to the updateFields.jsp file, you must add an entry to the diffIncident.jsp to save 
your new field information using a Web Service call. (For more information about creating Web Services, refer to the BMC 
Remedy Service Desk user manuals.)

To save the new field information:

1. Open the <APHOME>\webserver\webapps\mobilegateway\jsp\bmcremedysd\diffIncident.jsp file in an 
editor.

2. Add an entry similar to the following example:

if ( statusUpdated )
{
   // Update Status
   webService = "APSDI_HPD_HelpDesk_WS";
   operation = "MG_Set_Status";
   esr = mobileGatewaySession.createExternalServiceRequest();
   esr.setAction( "sendGenericRequest" );
   Map<String, String> statusFields = new LinkedHashMap<String, String>();
   statusFields.put("Status", updatedStatus );
   statusFields.put("z1D_Action", "MODIFY" );
   statusFields.put("Incident_Number", 
(String)updatedIncident.get("Incident_Number") );
   statusFields.put("Status_Reason", (String)updatedIncident.get("Status_Reason") 
);
   esr.addToken("fields", statusFields);
   esr.addToken("operation", operation);
   esr.addToken("webService", webService);
   esr.addToken("requestNS", webService);
   esr.addToken("responseNS", webService);
   %> 
   <%@ include file="includes/sendRequest.jsp"%>
   <%
   status = (String)resps.getResponse();
}

3. Set the webService variable to the name of a Web Service created in BMC Remedy Administrator.

• By default, in Web Services created with BMC Remedy Administrator request namespace (requestNS) and 
response namespace (responseNS) take on the value of the Web Service Name (webService).

4. Save and close the JSP file.

In the (String)updatedIncident.get("Status_Reason") section, “Status_Reason” is the fieldName set in the file 
updateFields.jsp.

Note: This integration does not currently support modifying Incidents created via Web Services.

5.1.0.1 Defining static lists
Static lists can be defined in loadLists.jsp:

  //Add the values for Reported Source fields
  List<String> reportedSource =
      Arrays.asList( new String[] {
        "",
        "Direct Input",
        "Email",
        "External Escalation",
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        "Fax",
        "Systems Management",
        "Phone",
        "Voice Mail",
        "Walk In",
        "Web",
        "Other"
  });
  staticLists.put( "ReportedSource", reportedSource );

In the above sample, “ReportedSource” can be used as a Field Type.

5.2 Add a Custom Query to the Home Page 
To add a custom query and link to the home page, add the following to the <APHOME>\webserver\webapps\ 
mobilegateway\jsp\bmcremedysd\configuration.jsp file installed on the Mobile Gateway: 

MAIN_MENU_OPTIONS.put("Query Label", "Qualification"); 

Note: For more information about constructing Qualifications for Service Desk, consult the BMC Remedy Service Desk 
documentation.

5.3 Creating a URL Alias
The urlAlias.jsp page in the Mobile Gateway is used to drive directly from an AlarmPoint notification to the Create 
Incident or Update Incident screens.  It supports the following parameters:

For example, if you wanted to load the incident with the current events incident_id and update the assignee to be the current 
User, you would insert the following code into the HTML email section of the presentation script:

  @person = @event::getRecipient($recipient.owner)
  $hasMobileAccess = $person.hasMobileAccess
  $accessibleServices =  @person::getAccessibleIntegrationServices($event.domain)
  $hasAccessToService = $accessibleServices::contains("bmcremedysd")
  IF ($hasMobileAccess && $hasAccessToService)
    @urlAlias = @event::createURLAlias()
    @urlAlias::setTarget("http://localhost:8888/mg/jsp/bmcremedysd/urlAlias.jsp")
    @urlAlias::setHost("http://localhost:8888")
    @urlAlias::setTimeout(3600)
    @urlAlias::setParameter("username", $person.targetName)
    @urlAlias::setParameter("IncidentNumber", $event.remedy_incident_id)
    @urlAlias::setParameter("Assignee", $person.targetName)
    $alias = @urlAlias::activate()

Name Description

newIncident If this parameter is set, a new incident will be created and you will be taken to the Create Incident 
Mobile Gateway screen.  If it is not specified, set this value to “1”.

IncidentID The incident number of the incident to update.  If the newIncident parameter is not set, this field 
must be set to a valid incident number.

Field Name The name of an API Caption of a field for the incident.  For each parameter set, it will update the 
field on the incident with that value
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    $content.message = $content.message & "<a href=\u0022" & $alias & 
"\u0022>Update
       Incident " & $event.remedy_incident_id & "</a>"
  ENDIF

Note: For more information about the URL Alias script object method, see the AlarmPoint Developer’s Guide & 
Scripting Reference.

5.4 Uninstalling
For instructions on removing an AlarmPoint deployment, refer to the AlarmPoint Installation and Administration Guide.
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6. Configuration Variable Reference
This section outlines and describes the configuration variables available in the Mobile Gateway and Integration Agent.

6.1 Mobile Gateway Configuration Variables
The following configuration variables are contained in the <APHOME>webserver\webapps\mobilegateway\jsp\ 
bmcremedysd\configuration.jsp file installed on the Mobile Gateway:

Variable Type Description Default Value

MAIN_MENU_COUNTS boolean Enables the queries on the home 
page to be run

true

MAIN_MENU_OPTIONS Map Defines what queries should be 
displayed on the homepage.

High Priority Incidents

Open Incidents Assigned To Me 

PAGINATE_RESULTS boolean Enables pagination of lists of 
incidents

true

RESULTS_PER_PAGE int Defines how many results should 
be displayed on each page of 
incidents

10

SD_USER_NAME_FIELD String Defines the name of the custom 
field containing Service Desk 
login credentials

“Service Desk User”

SD_PASSWORD_FIELD String Defines the name of the custom 
field containing Service Desk 
login credentials

“Service Desk Password”

VERIFY_SD_CREDS boolean Enables the validation of entered 
Service Desk login credentials 
when loading the homepage

true

SD_LISTS_EXPIRED long Defines how long (in 
milliseconds) to cache list values 
retrieved from Service Desk

3600000

MAX_SEARCH_RESULTS1 int Specifies the maximum number 
of objects returned for the initial 
search.

25

MAX_CASCADE_SEARCH 
_RESULTS2

int Specifies the maximum number 
of sample objects returned for 
the second search, based on the 
results of the initial search. 

50

MAX_CASCADE_SEARCH 
_RESULTS3

int Specifies the maximum number 
of sample objects returned for 
the third search, based on the 
results of the initial and second 
searches. 

25
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6.2 Search Categorization Variables 
The following Product and Operational Categorization lists are defined in the <APHOME>webserver\webapps\ 
mobilegateway\jsp\bmcremedysd\configuration.jsp file:  

6.3 Integration Agent Configuration Variables
The following configuration variables are found in the <IAHOME>\bmcremedysd\bmcremedysd.js file installed on the 
Integration Agent: 

SHOW_FINANCIALS Boolean Defines whether the financials 
screen is to be available when 
viewing an incident’s details.

true

SHOW_RELATIONSHIPS Boolean Defines whether the 
relationships screen is to be 
available when viewing an 
incident’s details.

true

Variable Type Description Default Values

productCategorizationTier1 list Contains the Product Categorization Tier 1 values 
from BMC Remedy. These values are used to 
populate the Tier 1 drop-down list for Product 
Categorization searches within the Mobile 
Gateway.

• Hardware
• Miscellaneous
• Network
• Service
• Software

productOperationalTier1 list Contains the Operational Categorization Tier 1 
values from BMC Remedy. These values are used 
to populate the Tier 1 drop-down list for 
Operational Categorization searches within the 
Mobile Gateway.

• Request
• Faliure

Variable Type Description Default Value

remedyURL String Defines the URL of the Service Desk web 
services

http://localhost

remedyServerName String Defines the name of the Remedy Service 
hosting Service Desk web services

REMEDYSD2k3

Variable Type Description Default Value
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7. Contacting AlarmPoint
You can access the AlarmPoint Systems Web Site at http://www.alarmpoint.com. From this site you can obtain information 
about the Company, the Products, Support and other helpful information. You may also access the Customer Support Site 
from the main web page. In this protected site you will find current product releases, helpful hints, patches, release notes,  
and other tools provided by AlarmPoint Systems, Inc. 

AlarmPoint Systems, Inc.

4457 Willow Road, Suite 220
Pleasanton, CA 94588

Phone: 925-226-0300 
Fax: 925-226-0310

E-mail: support@alarmpoint.com
Website: http://www.alarmpoint.com 
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8. Copyright
AlarmPoint Systems, Inc. produced this integration document to assist customers with joint BMC Software / AlarmPoint 
Systems implementations. BMC Software and AlarmPoint Systems have made every effort to ensure that the information 
contained in this document is accurate, but do not guarantee any accuracy now or in the future.

AlarmPoint Systems™ and AlarmPoint® are a trademark and registered trademark, respectively, of AlarmPoint Systems, 
Inc. in the United States, United Kingdom and other jurisdictions. All other trademarks are the property of their respective 
owners.

©AlarmPoint Systems 2009. Rights to reproduce this document only by written permission of AlarmPoint Systems.
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